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�LICENSE AGREEMENT FOR ZIFF-DAVIS’ WINBENCH® 96 VERSION 1.0

READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE EMBODIED IN THE WINBENCH® 96 VERSION 1.0 CD�ROM, DISKETTE(S), OR, IF PRELOADED ON YOUR HARD DISK, DOWNLOADED OR IF PROVIDED AS PART OF A COLLECTION, THE PRELOADED, DOWNLOADED OR COLLECTED FILE(S) (the “Media”). Embodied in the WinBench 96 Media is the WinBench 96 computer program and related documentation (the “Software”). Ziff-Davis Publishing Company, having a place of business at One Park Avenue, New York, New York 10016 (“Ziff-Davis”) is the licensor under this Agreement and you are the licensee. By using the Software, in whole or in part, you agree to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly return the Software to the Ziff-Davis Benchmark Operation at 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560 (or, if downloaded or preloaded on your hard disk, delete the Software, or if provided as part of a collection, cease use of the Software). Title to the Software and all copyrights, trade secrets and other proprietary rights therein are owned by Ziff-Davis. All rights therein, except those expressly granted to you in this Agreement, are reserved by Ziff-Davis.

1.	Limited License

This Agreement grants you only limited rights to use the Software. Ziff-Davis grants you a non-exclusive, non-transferable license to use the Software on a single dedicated computer or on a file server networked with multiple PC computers for the sole purpose of conducting benchmark tests to measure the performance of computer hardware and operating system configurations. You have the right to make a single copy of the Software for archival purposes and the right to transfer a copy of the Software across an internal local area network only to the PC computers attached to such network; provided, however, that all such copies are considered Software hereunder, that all uses of such copies are governed by the terms and conditions of this Agreement and that you shall be responsible for all uses of such copies in violation of the terms and conditions of this Agreement.

Ziff-Davis hereby grants you the right to publish, except in any country where a third party claims during the term of this license that such distribution infringes that party’s proprietary rights, benchmark test results obtained by you from your use of the Software provided that with the publication of each such result you: 

A.	Identify Ziff-Davis, the name and version number of the benchmark Software used (i.e., Ziff-Davis’ WinBench® 96 ver. 1.0);

B.	Identify the specific WinBench 96 score(s) being reported (i.e., Ziff-Davis’ WinBench® 96 ver. 1.0 Graphics WinMark™ 96);

C.	Identify the exact name, processor speed and type, amount of RAM, amount of secondary RAM cache, if any, hard disk model, type of hard disk controller, and size of hardware hard disk cache, if any, of the PC used for the test (e.g., WXY Corp. Model 466 with 66�MHz Intel® 486DX2�66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache); 

D.	Identify the exact graphics adapter name, amount and type of RAM on it, graphics driver name and date, refresh rate, Microsoft® Video for Windows® version, and CODEC version that produced the result (e.g., XYZ Corp. XYZ Graphics adapter with 2MB VRAM with XYZ.DRV version 1.1 driver, a refresh rate of 72 Hz, Microsoft Video for Windows version 1.1e, and Intel Indeo™ Video version 3.2 CODEC); 

E.	Identify the exact CD-ROM drive model, CD-ROM controller model, CD-ROM controller RAM cache size (if any), and CD-ROM-specific software cache and size (if any) that produced the result (e.g., XYZ Corp. XYZ CD-ROM Quad-Speed drive, XYZ Corp. CD-ROM controller, with no controller RAM cache and no CD-ROM specific software cache); 

F. 	Identify the operating system version (e.g., MS�DOS® 5.0 and Microsoft Windows 3.1), size and type of software disk cache, if any (e.g., SMARTDRV 2MB cache), graphics resolution and color depth (e.g., 800 by 600 pixels with 256 colors), and any other special conditions used to achieve the result (e.g., disk compression utility ABC version 1.0 enabled); 

G.	State that all products used in the test were shipping versions available to the general public;

H.	State that the test was performed without independent verification by Ziff-Davis and that Ziff-Davis makes no representations or warranties as to the result of the test; and 

I.	Follow proper trademark usage and acknowledge Ziff-Davis' trademark rights (e.g., “[ ] achieved a Graphics WinMark™ 96 score of X on WinBench® 96 ver. 1.0. WinBench is a registered trademark or trademark and WinMark is a trademark of Ziff-Davis Publishing Company in the U.S. and other countries.”). 

This Agreement and your rights hereunder shall automatically terminate if you fail to comply with any provision of this Agreement. Upon such termination, you agree to cease all use of the Software, cease the transfer of any copies of the Software and cease the publication of benchmark test results obtained by you from use of the Software. Further you agree to delete the Software and to destroy all tangible copies of the Software and other materials related to the Software in your possession or under your control, or, if downloaded or preloaded on your hard drive or if provided as part of a collection, to cease use of and to destroy any and all copies of the Software in your possession or under your control.

2.	Additional Restrictions

A.	You shall not (and shall not permit other persons or entities to) rent, lease, sell, sublicense, assign, or otherwise transfer the Software or this Agreement. Any attempt to do so shall be void and of no effect.

B. 	You shall not (and shall not permit other persons or entities to) reverse engineer, decompile, disassemble, merge, modify, include in other software or translate the Software, or use the Software for any commercial purposes, except for the publication of test results, as provided above.

C.	You shall not (and shall not permit other persons or entities to) remove or obscure Ziff-Davis’ copyright, trademark or other proprietary notices or legends from any of the materials contained in this package or downloaded.

D.	You acknowledge that the Software contains Ziff-Davis’ trade secret information and you agree not to disclose or disseminate such information other than as provided herein.

3.	Limited Warranty and Limited Liability

THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS ASSUME NO RESPONSIBILITY FOR THE ACCURACY OR APPLICATION OF OR ERRORS OR OMISSIONS IN THE SOFTWARE. IN NO EVENT SHALL ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS HAVE BEEN ADVISED OF THE LIKELIHOOD OF SUCH DAMAGES OCCURRING. ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGES OR COSTS, ARISING OUT OF, BUT NOT LIMITED TO, LOST PROFITS OR REVENUE, LOSS OF USE OF THE SOFTWARE, LOSS OF DATA OR EQUIPMENT, THE COSTS OF RECOVERING SOFTWARE, DATA OR EQUIPMENT, THE COST OF SUBSTITUTE SOFTWARE OR DATA, CLAIMS BY THIRD PARTIES, OR OTHER SIMILAR COSTS.

THE ONLY WARRANTY MADE BY ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS IS THAT THE ORIGINAL PHYSICAL MEDIA IN WHICH THE SOFTWARE IS EMBODIED AND WHICH IS DISTRIBUTED BY ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS SHALL BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP. ZIFF-DAVIS’ ENTIRE LIABILITY AND THE USER’S EXCLUSIVE REMEDY SHALL BE LIMITED TO THE REPLACEMENT OF THE ORIGINAL PHYSICAL MEDIA IF DEFECTIVE. THE WARRANTIES AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. NO ZIFF-DAVIS DISTRIBUTOR, AGENT OR EMPLOYEE, OR THIRD PARTY, IS AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO THIS WARRANTY.

SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES; SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

4.	U.S. Government Restricted Rights

The Software is licensed subject to RESTRICTED RIGHTS. Use, duplication or disclosure by the Government or any person or entity acting on its behalf is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS (48 CFR 252.227-7013) for DoD contracts, in paragraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause in the FAR (48 CFR 52.227-19) for civilian agencies, or in the case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or in other comparable agency clauses. The contractor/manufacturer is the Ziff-Davis Benchmark Operation, 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560.

5.	General Provisions

Nothing in this Agreement constitutes a waiver of Ziff-Davis’ rights under U.S copyright laws or any other Federal, state, local or foreign law. You are responsible for installation, management, and operation of the Software. This Agreement shall be construed, interpreted and governed under New York law. If any provision of this Agreement shall be held by a court of competent jurisdiction to be illegal, invalid or unenforceable, the remaining provisions shall remain in full force and effect.

Trademarks

MacBench®, NetBench®, ServerBench®, WinBench®, and Winstone® are registered trademarks and CPUmark™ and WinMark™ are trademarks of Ziff�Davis Publishing Company.

Compton’s Interactive Encyclopedia™ is a trademark of Compton’s New Media, Inc.

Corel GALLERY™ is a trademark of Corel Corporation.

dBASE® is a registered trademark of Borland International, Inc.

Microsoft®, MS-DOS®, and Windows® are registered trademarks and Encarta™ and Windows NT™ are trademarks of Microsoft Corporation.

Myst™ is a trademark of Cyan, Incorporated.

Intel® is a registered trademark of Intel Corporation.

Novell® is a registered trademark of Novell, Inc.

OS/2® is a registered trademark of International Business Machines Corporation.

Quicken® is a registered trademark and Quicken for Windows CD-ROM Deluxe Edition™ is a trademark of Intuit, Incorporated.

Copyrights

WinBench 96 Version 1.0 © 1993-1995. Ziff-Davis Publishing Company. All rights reserved.

�About this Handbook

This is the tester’s handbook for WinBench( 96. This handbook provides the minimum information you need to install WinBench, run its tests, and save the results. The handbook also includes some introductory material on how to read and analyze WinBench 96’s results. For additional information on what happens when you run a test and what can affect a PC’s results, see the Understanding and Using WinBench( 96 Version 1.0 manual.

NOTE:	Before you do anything with the software, you need to read the license agreement at the front of this handbook. (The same license agreement appears on the PC’s screen the first time you start WinBench 96.)

This section lists the different parts of this handbook, the conventions the handbook uses, and available WinBench 96 documentation.

Finding the information you need

This handbook includes the following parts:

Part 1:	� REF Part1NewFeatures \* MERGEFORMAT �New Features��Lists the changes and new features in this year’s benchmark.

Part 2:	� REF Part2BeforeYouBegin \* MERGEFORMAT �Before You Begin��Provides a list of WinBench 96’s minimum requirements and gives brief instructions on how to install the program’s files.

Part 3:	� REF Part3Running \* MERGEFORMAT �Running WinBench 96��Explains how to use the Configuration Information window, change test settings, run WinBench 96’s tests, save results, and run WinBench 96’s tests in batch mode.

Part 4:	� REF Part4Results \* MERGEFORMAT �Looking at the Results��Explains how to view results and briefly discusses what the results for the main tests mean about a PC’s performance.

Part 5:	� REF Part5ContactingZDBOp \* MERGEFORMAT �Contacting ZDBOp��Tells you how to contact us if you have technical questions or problems with WinBench 96.

This handbook also includes the following appendices:

Appendix A:	� REF AppendixABasicConcepts \* MERGEFORMAT �Basic Concepts��Briefly introduces WinBench 96’s main concepts.

Appendix B:	� REF AppendixBCustomConfigFile \* MERGEFORMAT �The Custom Configuration File��Explains in detail how to build a custom configuration file.

Appendix C:	� REF AppendixBVideo \* MERGEFORMAT �The Video Clips��Explains what you should see at certain frame numbers during each type of video test. Also includes a chart that maps each video test name to the .AVI video clip file that test runs and a chart that lists the attributes for each .AVI video clip file.

Conventions this handbook uses

This handbook uses a few general conventions. For example, it:

Uses the pronoun “we” to refer in general to either the Ziff-Davis Benchmark Operation (ZDBOp) or Ziff-Davis.

Uses bold type face for DOS and Windows® commands, file names, and directory names. For example, you’ll see sentences similar to the following:

“The WB96HBK.DOC file is in the \ZDBENCH\DOCS\WB96\HANDBOOK directory on the CD�ROM.”

Uses a monospace or typewriter font for information you must enter verbatim from the command line. The manual also displays system responses that appear on the PC’s screen in the same font. For example:

D:\ZDBENCH\WB96\SETUP.EXE

Uses the terms “select” and “choose” in the same way Windows documentation uses these terms. In Windows documentation, the terms “select” and “choose” have different, and specific, meanings. When you select an item, you mark it with the selection cursor, and the selection appears as a highlight, a dotted rectangle, or both. You also select check boxes in dialog boxes. Selecting alone doesn’t initiate an action.

You choose an item to carry out an action. For example, when you choose the WinBench 96 icon, WinBench 96 opens its main window. You can also choose an item from a menu or choose a command button in a dialog box. You often need to select an item before you can choose it.

Available WinBench 96 documentation

This document:�Is located in the:�And contains:��README.WRI�\ZDBENCH\WB96 directory on the CD�ROM or in the root directory on DISK 1.�The license agreement, a list of new features, and a list of known problems as of the CD�ROM’s release.��WinBench® 96 Version 1.0 Tester’s Handbook�(WB96HBK.*)�\ZDBENCH\DOCS\WB96\HANDBOOK directory on the CD�ROM. The CD�ROM may include three different formats of the handbook (.DOC, .TXT, and .RTF).�The minimum information you need to install WinBench 96, run the main tests, and analyze the results. (This is the document you’re reading now.)

The on�line help also contains most of the information in this tester’s handbook.��Understanding and Using WinBench® 96 Version 1.0�(WB96REF.*)�\ZDBENCH\DOCS\WB96\REF directory on the CD�ROM. The CD-ROM may include three different formats of the manual (.DOC, .TXT, and .RTF).�The WinBench 96 reference manual.��End of About this Handbook
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�Benchmark Request Form

Problem Report Form

�Part 1: �New Features

This part of the manual briefly explains some of the new features in this year’s benchmark. For detailed information on these features, see the Understanding and Using WinBench( 96 Version 1.0 manual.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM will not contain these tests. In addition, some CD-ROM versions may not include these tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests.

CD-ROM WinMark 96

WinBench 96 includes a new WinMark™—the CD�ROM WinMark 96. This suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem.

The CD-ROM tests measure the entire CD-ROM subsystem, which includes the CD-ROM drive, the adapter to which it is connected, the software drivers it requires to operate, any software caches, and the bus used to carry information from the controller to and from the processor subsystem. Any one of these pieces can affect the performance of the whole CD-ROM subsystem.

NOTE:	The test PC must have a CD-ROM drive and the CD-ROM that contains WinBench 96 must be in that drive before you can run any WinBench 96 CD-ROM tests.

For information on running the CD-ROM WinMark 96 suite, see the section “� REF _Ref335042337 \* MERGEFORMAT �Running selected tests�” on page � PAGEREF _Ref335042337 �13�. If you’d like to know what the CD-ROM WinMark 96 result means about a PC’s CD-ROM subsystem performance, see page � PAGEREF _Ref330267616 �25�.

Full-motion video tests

WinBench 96 includes new tests that provide concrete measures of a PC’s ability to play full-motion video. Unlike other WinBench 96 tests that focus on a specific subsystem’s performance, the new video tests stress many different parts of the PC’s hardware and software.

NOTE:	The test PC must have a CD-ROM drive and the CD-ROM that contains WinBench 96 must be in that drive before you can run any WinBench 96 video tests.

For information on running a video test, see page � PAGEREF _Ref330197959 �13�. If you’d like information on what the video test results mean, see the section “� REF _Ref337519810 \* MERGEFORMAT �The video tests�,” beginning on page � PAGEREF _Ref330276046 �26�. If you’d like a play-by-play of what you’ll see on the PC’s screen when you run a video test, see page � PAGEREF AppendixBVideo �39�.

Processor tests

WinBench 96 offers two new tests for measuring processor subsystem performance:  CPUmark32 and CPUmark16. The processor subsystem includes the PC’s CPU, RAM, cache, and cache controller.

As their names imply, the CPUmark32 and CPUmark16 tests measure the performance of x86 processors running different workloads.

The CPUmark32 measures the processor subsystem’s speed at running 32-bit Windows applications.

The CPUmark16 measures the processor subsystem’s speed at running 16-bit Windows applications.

Both tests are useful for obtaining a complete picture of a PC’s processor subsystem performance. Most of the new Windows applications are 32-bit products, and Windows 95 is largely a 32-bit operating system. The CPUmark32 is the right tool for measuring how well a PC’s processor subsystem will perform when running such software. At the same time, some applications are 16-bit products, and large portions of Windows 95 run as 16-bit code. For 16-bit code, the CPUmark16 is the right choice.

Whether one or both of the processor tests is appropriate to you depends on the mix of 32- and 16-bit applications you run.

For more information on the processor tests and what their results mean about a PC’s performance, see page � PAGEREF _Ref336313152 �26�.

The Configuration Information window

You can use WinBench 96’s new Configuration Information window to compare the test PC with either a pre-set list of optimization tips or a custom configuration file you create. (For information on disabling the configuration check, see page � PAGEREF _Ref335017907 �10�.)

NOTE:	You can open the Configuration Information window from the Run menu on the main window menu bar without running a test.

The Configuration Information window has two sections:

Optimization Tips. Compares the PC’s setup and configuration to a pre-set list of optimization tips.

Custom Configuration File. Compares the PC’s setup and configuration to a custom configuration file. For more information, see page � PAGEREF _Ref327694797 �10�.

For information on how to use this window, see page � PAGEREF _Ref329660804 �9� of this handbook or Chapter 8, “Using the Configuration Information Window,” in the Understanding and Using WinBench® 96 Version 1.0 manual.

Disclosure fields for multimedia

WinBench 96 includes new Disclosure fields for multimedia. The following table lists the new fields as they appear in the WBN_SYS.DBF results file.

�NOTE:	The following list shows the fields exactly as they appear in the results file. If you use a .DBF�compatible application to view the file, the fields may appear in a different order.

Result:�Result field name:�Field type:�Width (bytes):��CD-ROM drive description�CD_DRV_DES�Character�80��CD-ROM controller description�CD_CONT_DE�Character�80��CD-ROM controller RAM �CD_CONT_RA�Character�10��CD-ROM software cache description�CD_SCH_DES�Character�80��CD-ROM software cache size�CD_SCH_SZ�Character�10��Sound adapter description�SND_ADP_DE�Character�80��Video for Windows version �VFW_VER�Character�20��Win32s version�WIN32S_VER�Character�20��Windows drivers�WIN_DRVS�Memo���If you’d like more information on using the database files, see the section “� REF _Ref335042388 \* MERGEFORMAT �Working with database files�” beginning on page � PAGEREF _Ref335042388 �19�. For additional information on the database fields WinBench 96 uses, see Appendix A, “The Database Files,” in the Understanding and Using WinBench® 96 Version 1.0 manual.

Error messages log file

WinBench 96 logs all error messages in a file named ERRORS.TXT in the parent directory in which you installed the benchmark (probably \ZDBENCH). (WinBench 96 shares this log file with Winstone® 96.) The automatic logging feature frees you from having to keep track of any error messages WinBench 96 may display during a test run.

You can view the ERRORS.TXT file with any text editor.

End of Part 1

�Part 2: �Before You Begin

This part of the handbook lists the minimum requirements a PC must meet to run WinBench 96 and its tests. This part also explains how to install WinBench 96’s files from the CD-ROM, a set of installation diskettes, and a downloaded file.

WinBench 96 minimum requirements

If the PC doesn’t meet WinBench 96’s minimum requirements, WinBench 96 won’t be able to run the tests properly. The following chart lists the minimum requirements to install and run WinBench 96.

Windows 3.1 or 3.11* or�Windows for Workgroups 3.1 or 3.11*��Windows 95�Windows NT 3.5* or later��OS/2® Warp*��MS-DOS® (or compatible) version 5.0 or later or Novell® DOS 7�N/A�N/A�N/A��Video for Windows version 1.1E† �N/A�N/A�Video for Windows version 1.1E†��Win32s 1.25†�N/A�N/A�Win32s 1.1†��Microsoft CD Extension software or equivalent�N/A�N/A�N/A��8MB RAM�8MB RAM�minimum RAM the operating system requires�minimum RAM the operating system requires��6MB of free space on the PC’s hard disk and an additional 58MB plus the size of RAM of free space �for temporary files the Disk WinMark 96 suite uses��80386 (or compatible) or higher processor��CD-ROM drive��Sound card‡ ��VGA resolution (640x480) or higher graphics adapter��

Installing WinBench 96

To install WinBench 96’s files, you execute SETUP.EXE. The setup program prompts you for information in a series of screens that are essentially self�explanatory. If you’re an experienced PC user, you may not need to read this part of the handbook.

Depending on how you received WinBench 96, the installation may be slightly different. Basically, you always run SETUP.EXE to install WinBench 96’s files. If you received the software on diskettes or if you downloaded a file, you do, however, have a couple of added steps during installation.

To make it easier to find the information you need, this part of the handbook include three sections. If you have:

A CD-ROM, read the next section “� REF _Ref328881205 \* MERGEFORMAT �Installing from the CD-ROM�.”

A set of installation diskettes, read the section “� REF _Ref333140082 \* MERGEFORMAT �Installing from diskettes�” on page � PAGEREF _Ref333140089 �6�.

NOTE:	If you received WinBench 96 on CD-ROM and need to make a set of installation diskettes, see the README file in the \ZDBENCH\DISKETTE directory on the CD�ROM.

A downloaded file, read the section “� REF _Ref328820115 \* MERGEFORMAT �Installing if you downloaded WinBench 96�” beginning on page � PAGEREF _Ref328820115 �7�.

Installing from the CD-ROM

To install WinBench 96 from the CD-ROM, run SETUP.EXE from the \ZDBENCH\WB96 directory on the CD-ROM.

NOTE:	If you received WinBench 96 on CD-ROM, that CD-ROM may contain the Ziff�Davis PC Benchmarks Installer program. With this installer program, you can install both WinBench 96 and Winstone 96, as well as other programs WinBench 96 requires, at one time. If you’re running Windows 95, the installer program starts automatically if the CD-ROM is in the CD-ROM drive. If you need to start the installer program, execute INSTALL.EXE from the CD-ROM’s root directory using the File | Run command under Windows.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

Once the setup program begins installing the files, it displays a status bar to let you know how it’s doing. When installation is complete, WinBench 96 displays a message telling you it’s done.

Installing from diskettes

To install WinBench 96 from diskettes, run SETUP.EXE from DISK 1.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM, including the versions you can download from CompuServe and the World Wide Web, will not contain these tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests.

For example, if the PC’s floppy drive is the A drive, you would use the following command line:

A:SETUP.EXE

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

Once the setup program begins installing the files, it displays a status bar to let you know how it’s doing. The setup program prompts you when it’s ready for the next diskette. When installation is complete, WinBench 96 displays a message telling you it’s done.

Installing if you downloaded WinBench 96

When you downloaded WinBench 96, you downloaded the file WINBEN.EXE.

NOTE:	The test files WinBench 96 uses for the CD-ROM and full�motion video tests are very large. To save space, all versions of WinBench 96 not on a CD-ROM, including the versions you can download from CompuServe and the World Wide Web, will not contain these tests.

	You can use the Benchmark Request Form to request a full version of WinBench 96 which includes the CD-ROM and full�motion video tests.

To install WinBench 96, follow these steps:

1.	Copy the WINBEN.EXE file from the directory where you downloaded it to a temporary directory.

NOTE:	The temporary directory must not be the same directory where you plan to install WinBench 96.

2.	Change directories to the temporary directory and run WINBEN.EXE. You can run the file by:

Selecting Run from the File menu in the Program Manager window. Then type the path name of the temporary directory and WINBEN.EXE in the Command Line text box.

Double-clicking on the file name from the file manager window.

Running WINBEN.EXE extracts the WinBench 96 setup files and places them in the temporary directory. One of these files is SETUP.EXE.

3.	Run SETUP.EXE from the temporary directory.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want WinBench 96 to install its files. Each of these screens contains text explaining what you should do.

When the setup program begins installing the files, it displays a status bar to let you know how it’s doing. When installation is complete, WinBench 96 displays a message telling you it’s done.

4.	Delete the temporary directory once the setup program completes.

NOTE:	You may want to copy the WINBEN.EXE file to another directory before you delete the temporary directory so you can install WinBench 96 again if you need to without having to download the file again.

Installing Video for Windows

If the PC under test is running Windows 3.1 or 3.11 or Windows for Workgroups 3.1 or 3.11, you must install Video for Windows before you can run any of WinBench 96’s full-motion video tests. (You don’t need to install Video for Windows if the test PC is running Windows 95 or Windows NT.)

To install Video for Windows, run SETUP.EXE from the \VFW\11E directory on the CD�ROM.

Installing Win32s

If you want to run the Processor/32-bit test or the CPUmark™32, you must install the Win32s subsystem. (You don’t need to install Win32s if the test PC is running Windows 95 or Windows NT.) There are two versions of Win32s on the CD-ROM—versions 1.1 and 1.25. The version of Win32s you install depends on the operating system running on the test PC.

If the PC is running:�Execute SETUP.EXE from this directory on the CD-ROM:��OS/2�\WIN32S\11\DISK1��Windows 3.1 or 3.11 or�Windows for Workgroups 3.1 or 3.11�\WIN32S\125\DISK1��End of Part 2

�Part 3: �Running WinBench 96

This part of the handbook tells you about the new Configuration Information window, explains how to use the improved Test Setting dialog box, and steps you through the process of running tests, getting results, and saving those results to the database. This part also briefly explains how to run WinBench 96 in batch mode and how to create custom test suites.

NOTE:	Before you run any WinBench 96 tests, you’ll need to license and register your copy of the software.

We’ve written this part of the handbook with the assumption that WinBench 96 is installed and ready to run on the PC and that you understand a little about WinBench 96 and how it works. For more detailed information on using WinBench 96’s buttons, menus, and windows, see the Understanding and Using WinBench( 96 Version 1.0 manual.
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Using the Configuration Information window

You can use the Configuration Information window to check a PC’s configuration to make sure it meets a minimum set of requirements. This window has two sections:

Optimization Tips

Custom Configuration File

When WinBench 96 displays this window, the section that contains any warnings will be on top. For example, if WinBench 96 finds a setting in the PC’s system files that differs from the pre-set list of optimization tips, it will display the Optimization Tips section first. (You can look at the other section if you’d like. Just click on the button at the top of the window that corresponds to the section you wish to view.)

In the top left corner of the Configuration Information window, you’ll find the Options drop�down menu. You can use this menu to tell WinBench 96 what areas to check before running tests (for example, you can have WinBench 96 check the Optimization Tips and nothing else) and to load or unload a custom configuration file.

�Optimization Tips

When WinBench 96 performs its configuration check, it notes areas where the PC differs from a pre-set list of optimization tips. For example, when you run WinBench 96, the load= option in the [Windows] section of the PC’s WIN.INI file should be empty. So, if load= entry isn’t empty, WinBench 96 lists this difference on the Optimization Tips page.

For information on why a certain setting may cause problems for WinBench 96, highlight the setting in the Configuration Information window and WinBench 96 displays an explanation at the bottom of the window.

Custom Configuration File

In addition to comparing the PC to a list of pre-set optimization tips, you can also use a custom configuration file. Then, when WinBench 96 performs its configuration check, it will compare the pre�defined settings in the custom configuration file with the settings the test PC uses. If you’re testing multiple PCs, you can use a custom configuration file to assure that each PC matches the custom settings.

WinBench 96 includes a sample configuration file (SAMPLE.CFG) in the directory where you installed the benchmark (probably \ZDBENCH\WB96).

To create a custom configuration file, first copy the SAMPLE.CFG file to another file name (for example, CUSTOM.CFG). Then, edit the custom file so it contains the settings you want. (For information on the different settings the SAMPLE.CFG file contains, see page � PAGEREF AppendixBCustomConfigFile �33�.)

After you’ve edited the custom file and before you run any WinBench 96 tests, go to each PC you want to test and follow the steps below:

1.	Select Run | Configuration Information... from the WinBench 96 main window.

2.	Select Option | Load custom configuration file... from the Configuration Information window.

3.	Enter the directory and file name of the custom file in the Load Custom Configuration File dialog box.

4.	Select OK.

After you load the custom file, WinBench 96 continues to check differences between the custom file and the PC under test for the remainder of the current session and in future sessions on that PC until you unload the file.

To unload a custom configuration file:

1.	Select Run | Configuration Information... from the WinBench 96 main window.

2.	Select Options | Unload custom configuration file from the Configuration Information window.

Disabling WinBench 96’s configuration check

You may want to disable the configuration check if you’re running WinBench 96 on the same PC over and over again without changing that PC’s configuration. Once WinBench 96 performs the configuration check and you’re sure the PC is set up correctly, you can then disable the check. You can also tell WinBench 96 to perform only certain portions of its configuration check. For example, you could have the program check a Custom Configuration File but not check for Optimization Tips.

NOTE:	If you change the PC’s configuration at all, you should enable the configuration check. The configuration check is a good way to be certain WinBench 96 will complete the test without problems.

To disable one portion or all of the configuration check:

1.	Select Options | Check before running tests from the Configuration Information window.

2.	From the sub-menu WinBench 96 displays, select those areas you want the program to check.

If you don’t select any of the items in this list, WinBench 96 doesn’t perform its configuration check.

Until you change these options , WinBench 96 will perform the configuration checks you select for the current session and for future sessions.
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Changing test settings

If you’re going to run WinBench 96’s CD-ROM, disk, or video tests, you can change the test settings for these tests using the Test Settings dialog box. The test settings remain in place for all WinBench 96’s tests until you exit the program. The next time you start WinBench 96, it uses the default test settings.

To change test settings:

1.	Select Settings... from the Edit menu in the main menu bar. WinBench 96 displays its Test Settings dialog box.

2.	Select the group on the left-hand side of the window that corresponds to the settings you wish to change.

When you select one of these groups, WinBench 96 changes the Test Settings dialog box to display the information about that group. For example, if you want to change the drive settings for the CD-ROM and disk tests, select the button to left of Drives. WinBench 96 then changes the display in the dialog box to the Disk and CD-ROM Drives page.

3.	Once you have the settings the way you want, choose the Update Settings button.

If at any point you wish to exit the Test Settings dialog box without saving your changes, choose the Cancel button.

Running the All Marks suite

WinBench 96’s main tests are the:

Graphics WinMark 96�Disk WinMark 96�CD-ROM WinMark 96�CPUmark32�CPUmark16

To run the main tests:

1.	Choose WinBench 96 from the Ziff-Davis Benchmarks program group to open the main window.

NOTE:	If you haven’t previously licensed WinBench 96, you’ll have to read and agree to the license agreement before you can continue.

	If WinBench 96 fails during initialization with a General Protection Fault (GPF) or system hang, you can use three command line options to disable WinBench 96’s automatic detection of some disclosure fields.

The NOCPUCHECK option prevents WinBench 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK option prevents WinBench 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after WinBench 96 initializes.

The NOREGCHECK option prevents WinBench 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

2.	Choose the Run button. (When you open the main window, WinBench 96 displays “All Marks” in the list of names to the right of the Run button. So, choosing the Run button runs all the main tests.)

NOTE:	To run the CD-ROM WinMark 96, the CD-ROM that includes WinBench 96 must be in the test PC’s CD�ROM drive.

If you want to run individual WinBench 96 tests, see page � PAGEREF _Ref332702489 �12�.

If you want to run WinBench 96 in batch mode, see page � PAGEREF _Ref325970578 �14�.

The time WinBench 96 takes to run the main tests varies based on the PC’s speed and configuration. Here are a few examples to give you an idea of how long it took to run these tests on machines in our research center. Faster machines will take less time, while slower machines will take more time.

A typical:�Took approximately this much time:��Pentium™ 100 with 32MB of RAM and a quad-speed CD�ROM drive.�24 minutes��Pentium 66 with 16MB of RAM and a double-speed CD-ROM drive.�32 minutes��486DX2/66 with 16MB of RAM and a single-speed CD-ROM drive.�1 hour 5 minutes��While WinBench 96 is running the main tests, it displays status messages on the PC’s screen. When the tests complete, WinBench 96 displays the PC’s results in the Chart of Results.

Interrupting a test run

If you need to interrupt a test run, press the Esc key. WinBench 96 halts the current test and cleans up any test files.

NOTE:	It may take a while for WinBench 96 to halt the current test.

	If you halt a test before it is complete, WinBench 96 will not produce results for that test.

Saving results

After WinBench 96 finishes a test run, it automatically displays its results in the Chart and Table of Results windows.

To save results:

1.	Choose the Save button from the WinBench 96 functions window.

WinBench 96 displays the Save to Database dialog box.

NOTE:	You must enter a Description for the test run before you can save results. If you haven’t entered a Description, WinBench 96 prompts you for that information before you can continue the save operation. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy. After you’ve entered a Description and verified the other fields, choose the Continue with Save button.

2.	Choose the Save button in the Save to Database dialog box.

WinBench 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

NOTE:	You can change the destination database by choosing the Database button in this window.

Running selected tests

In addition to running the WinMark 96 tests and other built�in WinBench 96 suites, you can run selected suites and tests using the Select Tests dialog box. You can display this dialog box in two ways:

Choose Selected... from the drop-down list to the right of the Run button.

Choose Select and Run Tests... from the Run drop-down menu.

Either option opens WinBench 96’s Select Tests dialog box.

To add a suite or test to the list of Selected Tests:

1.	Select the name of the suite or test.

2.	Choose the Add button. (You can also double-click on the name to add it to the list of Selected Tests.)

To delete names from the list, use the Remove and Remove All buttons. The Remove button deletes only the highlighted names in the list. The Remove All button deletes all the names from the list.

3.	Choose OK after you’ve got the list under Selected Tests the way you want it.

NOTE:	If you opened the Select Tests dialog box using the Select and Run Tests... option in the Run menu, WinBench 96 runs the tests under Selected Tests as soon as you choose OK.

	If you opened the Select Tests dialog box by choosing Selected... from the list to the right of the Run function button, WinBench 96 returns you to its main window. To start the tests, choose Run.

Running the full-motion video tests

To run a video test, you use the Select Tests dialog box. (For information on using this dialog box, see the previous section, “� REF _Ref333120951 \* MERGEFORMAT �Changing test settings�.”)

NOTE:	To run a video test, you must have the CD-ROM that contains WinBench 96 in the drive. The new video tests require a particular set of AVI clips located on the CD-ROM.

�From the Select Tests dialog box, add the video test name(s) you wish to run. (There is no weighted suite for the video tests.) Each video test name begins with the word “Video.” A standard video test name uses the following construction:

Video/<clip type>, <CODEC>, <resolution>, <frames per second>, <minimum data rate>

This part of the video test name:�Tells you:��<clip type>�The type of video clip (whether it is a talking head or action video clip).��<CODEC>�The name of the CODEC that decompresses the video clip when WinBench 96 plays it.��<resolution>�The screen resolution of the video clip (how wide and how high the picture is, in pixels).��<frames per second>�The number of frames per second (fps) at which the video clip plays.��<minimum data rate>�The data rate (in kilobytes per second or KB/S) for the CD-ROM drive required to support playing the video clip without dropping frames (assuming the rest of the system doesn’t introduce a bottleneck).

The data rate:	Indicates a:

150KB/S	single-speed CD-ROM drive�300KB/S 	double-speed CD-ROM drive�450KB/S 	triple-speed CD-ROM drive�600KB/S 	quad-speed CD-ROM drive�900KB/S	six-speed CD-ROM drive��For example, the test name:

Video/Head, Cinepak, 320x240, 15 fps, 300KB/S

tells you:  the clip is a video test of a talking head, decompressed with the Cinepak CODEC, with a resolution of 320x240 pixels, at 15 frames per second, and playable on a double-speed CD-ROM drive without dropped frames.

A video test name may also provide other information about the test.

If the name �contains this field:��It means WinBench 96:��nx�Scales the video clip (makes it larger) by a factor of n in both dimensions (n2 in area).��Full�Displays the video clip to fill the WinBench 96 main window.��Clipped�Displays a clipping window on top of the video clip while it plays.��Unaligned�Does not align the video clip window on an 8-pixel boundary.��Running WinBench 96 in batch mode

You don’t have to sit at the PC and click the buttons to run WinBench 96’s tests. To make the best use of your time, you may decide to run WinBench 96 in batch mode. When you run WinBench 96 this way, it gets the information it needs to run the tests from a file called RUNWB.INI. This file supplies the environment settings, the names of the tests WinBench 96 will run, and the names for the database files it produces. WinBench 96 installs a prototype RUNWB.INI file in its main directory (by default \ZDBENCH\WB96).

NOTE:	You can only use the WinBench 96 RUNWB.INI file with WinBench 96. WinBench 95 won’t accept this file format.

�1.	Copy the RUNWB.INI prototype file to another file name (for example, MYFILE.INI).

2.	Edit the new file so it contains the information WinBench 96 needs.

You can use any text editor to modify this file. You can also use the StepN section(s) of this file to refer to custom test suite files that define a set of tests to run in that step. (See the section “� REF _Ref328887364 \* MERGEFORMAT �Creating a custom test suite�” on page � PAGEREF _Ref328887364 �15� for more information.)

For complete information on the different sections of the RUNWB.INI file you can modify, see Chapter 10, “Running WinBench 96’s Tests,” in the Understanding and Using WinBench( 96 Version 1.0 manual.

3.	After you’ve edited and saved the new file, run WinBench 96 with the AUTO command option and specify the name of the new file.

For example, if MYFILE.INI is the edited copy of the prototype file, you’d use the following command line:

WB96 AUTO MYFILE.INI

How you execute WinBench 96 depends on the Windows shell you’re using.

If you’re using Program Manager, select Run from the Program Manager File menu. Use the Browse feature to enter the WinBench 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you’re using Explorer, select Run from the Start menu. Use the Browse feature to enter the WinBench 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you want to automate this process so WinBench 96 runs in batch mode each time Windows starts, you can add the WinBench 96 icon with the AUTO command line option and the name of the .INI file to the Windows StartUp group.

Creating a custom test suite

A custom test suite is a collection of tests you create that contains just the suites and/or tests you want to run. When you create a custom test suite, you save it as a file. You can then add that suite’s name to the list of available tests during any WinBench 96 session.

NOTE:	While you can create custom test suites, you can’t assign weights to the tests in those suites.

To create a custom test suite:

1.	Select Create... from the Suite menu.

WinBench 96 displays the Create Custom Suite dialog box.

2.	Enter a name for the test suite under Suite Name. You can use any combination of characters and spaces for this name.

Once you’ve added the suite’s name to the list of available tests, the name you enter here will appear in the drop�down list to the right of the Run button and in the Test Suites list in the Select Tests dialog box.

3.	Build a custom test suite by adding names to or removing names from the list of Selected Tests.

�NOTE:	WinBench 96 automatically displays the names of the tests included in the currently selected suite under Selected Tests.

	For example, if you’ve selected Graphics WinMark 96 from the list of available suites to the right of the Run function button, WinBench 96 lists the tests that make up the Graphics WinMark 96 under Selected Tests in this dialog box.

	If you don’t want to use any of the tests listed, choose the Remove All button.

You add tests by double�clicking on the test names or by selecting a name and then choosing the Add button.

You remove tests by choosing a name and then choosing the Remove button

4.	Choose OK when you have all the tests you want listed in the Selected Test window. WinBench 96 displays the Save Suite in File dialog box.

NOTE:	At this point, you have a suite you can run during this WinBench 96 session. You don’t have to save the suite to a file. If, however, you want to run this suite during other sessions, you’ll need to save the suite to a file. If you want to save the custom test suite, go to the next step. If you don’t, choose Cancel.

5.	Enter a file name for the suite with a .WBS extension.

You can change the directory and drive where you want to save the file. By default, WinBench 96 saves the file in its SUITES subdirectory. (You must follow DOS file name conventions when you enter the name for this file.)

NOTE:	If you save the suite to a file, WinBench 96 associates a file name with the suite you create. That file name must follow DOS file name conventions. Later, when you want to load the suite, you’ll need to select the DOS file name, not the actual suite name.

	For example, suppose you create a suite named “Rosco Test 1” and save it as a file named ROSCO1.WBS. When you want to load that suite, WinBench 96 displays a dialog box with the file name ROSCO1.WBS in it, not the suite name “Rosco Test 1.”

6.	Choose OK. WinBench 96 automatically adds the name of the suite you just created to the list of available suites in both the drop�down list to the right of the Run function button and the Test Suites list in the Select Tests window.

End of Part 3

�Part 4: �Looking at the Results

This part of the handbook discusses WinBench 96’s results. The sections in this part briefly explain how to view results, use the results database, change and print Disclosure information, and interpret and analyze the numbers you see.

Viewing results

You view results from the Chart and Table of Results windows. After you run a test, WinBench 96 automatically displays the results for that test in the Chart of Results. The Chart of Results shows the name of the test and the result for that test in a horizontal bar graph.

Adding results to the display

To add results to the Chart and Table of Results windows, choose the Compare... button in the Functions window. WinBench 96 then displays the Comparison Machines dialog box. (You only need to add results to these windows if you want to view results other than the current results.)

You can display up to five sets of comparison results in the Chart and Table of Results windows. You can also set a baseline system in these windows so you can easily compare different sets of results (see page � PAGEREF _Ref335040502 �18� for more information).

From the Comparison Machines dialog box, you can add results from:

A database by choosing the Add from Database... button.

An exported file by choosing the Import from File... button.

Changing the display

You can use the Display option from the Edit drop-down menu to change the way WinBench 96 displays its results.

Choosing this option:�Displays:��All Tests�Results for all tests.��All Marks�Results for the CD-ROM, Disk, and Graphics WinMark 96 suites as well as the results for both CPUmark tests.��Tests Run�Results just for the tests run during the current session.��Selected Tests�Results for the tests as specified in the drop-down list of tests to the right of the Run function button. For example, if the drop-down list displays “All Marks,” then WinBench 96 would display results for all the tests that make up the CD-ROM, Disk, and Graphics WinMark 96 suites as well as both CPUmark tests.��Removing results from the display

To remove a set of results from the Chart and Table of Results:

1.	Choose the Compare... button in WinBench 96’s Functions window to open the Comparison Machines dialog box.

This dialog box lists all the results currently displayed in the Chart and Table of Results. (You can display up to four sets of comparison results in the Chart and Table of Results.)

2.	Select the set of results you’d like to remove from the display, and then choose Remove.

WinBench 96 removes that set of results from the Chart and Table of Results. It doesn’t, however, permanently delete those results from the database. (If you’d like to know how to permanently remove results from the database, see page � PAGEREF _Ref330190651 �20�.)

Setting or changing the baseline system

When you display results, you can choose which set of results you want to use as a baseline system. With a baseline system, you can quickly compare all the results to that one set of results in WinBench 96’s Chart of Results.

When you select a baseline system, WinBench 96 sets that system’s results to 1.00 and displays all other results as a fraction of the baseline system’s results. When you use a baseline system, you can quickly determine from the graphs how results for different PCs compare.

For example, once you’ve set the baseline system, the bar graph for a set of results that is faster (or better) than the baseline system’s will be more than 1.00, while the bar graph for a set of results that is slower (or worse) than the baseline system’s will be less than 1.00.

To specify or change the current baseline system:

1.	Select Baseline... from the Chart menu.

WinBench 96 displays the Baseline Machine dialog box.

To see a list of the currently displayed results, select the down arrow to the right of the Baseline text box.

2.	Set or change the baseline machine by selecting a set of results you want WinBench 96 to use as the baseline machine.

You can select any set of results WinBench 96 is currently displaying as the baseline machine.

NOTE:	To select Baseline... from the Chart menu, the Chart of Results must be open and you must have normalized results displayed in the chart. Otherwise, the Baseline... option is dimmed (you can’t select it).

3.	Once you’ve selected the machine, choose OK.

�Printing results

You can print the current results, the Chart and Table of Results, and the Disclosure using the Print option from the File menu.

If you want to print . . .�Then choose . . .��The results and Disclosure information for tests run during the current session.�Current results.��The current contents of the Chart of Results and/or the Table of Results.�Chart of Results and/or Table of Results.��Disclosure information.�Disclosure. (WinBench 96 prints the Disclosure information for the current results. If you want to print Disclosure information for other sets of comparison results, change the Description listed at the top of the Disclosure window before selecting Print from the File menu.)��When you choose one of these options, WinBench 96 prints to the currently selected default printer.

Working with database files

WinBench 96 saves results and disclosure information in a database format it shares with Winstone 96. You use results stored in a database as comparison machines in the Chart and Table of Results windows.

WinBench 96 stores results in a database directory. The database directory typically has an extension of .ZDB. The database directory contains many dBASE(�compatible tables and indexes.

If you installed WinBench 96 in a subdirectory of \ZDBENCH, the setup program creates a database directory called \ZDBENCH\RESULT96.ZDB. If you didn’t install WinBench 96 under a common \ZDBENCH directory, it creates the RESULT96.ZDB database directory in the directory where you installed the program files. WinBench 96 can’t then share the database with Winstone 96.

When you’re working with database files:

Always treat a database directory as a single object.

Always move, copy, or delete the entire directory.

Never move, copy, delete, or rename the files in a database directory.

Never use a dBASE-compatible database management system to edit the database directory. Doing so may break the relationship between the files and the benchmark, and you’ll lose the results.

NOTE:	You can merge the contents of one database into another using the Merge Databases... option from the File drop-down menu. WinBench 96 copies all results from the source database to the target database. (For more information, see page � PAGEREF _Ref335042295 �20�.)

WinBench 96 stores results in a database using a key consisting of the Description, Variant1-5, PIN, and Project fields of the Disclosure. You can store many sets of results using the same key. WinBench 96 distinguishes the results by a unique time stamp.

The following sections explain how to work with WinBench 96’s database files.

Merging results into one database

WinBench 96 lets you merge results from one database into another. When you merge two databases, you specify a target database and a source database. The target database is the database to which you wish to add results. The source database contains the records you wish to add to the target database.

To merge databases:

1.	Select Merge Databases... from the File menu in the main menu bar. WinBench 96 then displays its Merge Databases dialog box.

2.	Select the target and source databases.

3.	Choose Merge.

WinBench 96 adds all the records from the source database to the target database. To view these records, you need to add them to the display (see page � PAGEREF _Ref330354507 �17�).

NOTE:	Depending on the number of records in the source database, it may take a while to merge the records from one database to another.

Exporting results

In addition to saving results to a database, you can export results to an ASCII text file (.TXT), a Lotus 1�2�3 spreadsheet (.CSV), an Excel spreadsheet (.XLS), or a Windows Metafile (.WMF) for use in other applications. You can also export WinBench 96’s Test Screen to a .BMP file.

To export results:

1.	Select Export from the File menu.

You can export:�Which contains:�To this format:��Current Results�Results and Disclosure for the tests run in the current session�.TXT, .CSV, or .XLS��Chart of Results�Results the Chart of Results currently displays�.WMF��Table of Results�Results currently listed in the Table of Results�.TXT��Disclosure�The information currently listed in the Disclosure window�.TXT��Test Screen�The contents of the Test Screen�.BMP��	Choosing any of the above options from the Export submenu displays the Export Results to File dialog box.

2.	Enter the name of the file in the File Name dialog box. (You can change the drive and directories using the Drives and Directories portions of this dialog box.)

3.	Choose OK.

WinBench 96 saves the results to the file name and format you specified.

Deleting results permanently from the database

To permanently delete a set of results from the database:

1.	Select Delete... from the File menu in the main menu bar. WinBench 96 then displays its Delete Results from Database dialog box.

NOTE:	WinBench 96 only lets you delete select records from its database. You can’t delete an entire database from within WinBench 96.

When you open the Delete Results from Database dialog box, WinBench 96 automatically displays all the records in the current database. (To change the database, choose the Database... button.)

2.	Locate the record(s) you want to delete from the list of records.

To select more than one record, hold down the Shift key then click on the additional record name(s).

3.	Choose Delete.

WinBench 96 prompts you with a warning asking if you’re sure you want to delete the selected record(s).

4.	Choose Yes, and WinBench 96 removes the selected record(s) from its database and closes the dialog box.

Working with Disclosure information

When you start WinBench 96, it checks the PC’s configuration and stores the information it finds in the Disclosure. When you save a set of results, WinBench 96 saves the disclosure information for that set of results. If you publish results, you’ll need to include information in the Disclosure with the results you publish.

NOTE:	If you run and save several tests on the same PC with the exact same configuration, WinBench 96 only stores the PC’s configuration information once to conserve disk space.

This section explains how to view, edit, and print Disclosure information.

Viewing Disclosure information for the current displayed results

To view the disclosure information for each set of results currently displayed in the Chart and Table of Results, choose Edit | Disclosure from WinBench 96’s main menu.

By default, WinBench 96 displays the disclosure information for the current set of results first. WinBench 96 uses a drop�down list to display the Description for each set of results you’re currently displaying.

Disclosure information for a PC will most likely cover more than one page of the Disclosure window. Use the scroll bars to view portions that don’t fit within the boundary of the window.

Viewing Disclosure information for other sets of results

To look at disclosure information for another set of results:

1.	Select the down arrow to the right of Current Results.

2.	Select the Description for the set of results whose Disclosure information you wish to view.

WinBench 96 then changes the display to show the Disclosure information for that test run.

Editing the Disclosure Questionnaire

If you need to add to or change the Disclosure information about the PC, you can edit WinBench 96’s Disclosure Questionnaire. There are two ways to edit the questionnaire. You can choose:

The Edit button if the Disclosure window is open.

The Disclosure Questionnaire option from the Edit menu in the main window menu bar.

Either of these actions opens the Disclosure Questionnaire window.

To update the Disclosure Questionnaire:

1.	Select the group on the left-hand side of the window that corresponds to the area of the Disclosure you wish to edit.

When you select one of these groups, WinBench 96 changes the Disclosure Questionnaire window to display just the information about that group. For example, if you want to edit the Description, select the button beside Description, and WinBench 96 changes the display in the window to the Description information.

NOTE:	WinBench 96 by default displays the first group, Instructions, each time you open the Disclosure Questionnaire.

2.	Once you have the Disclosure Questionnaire information the way you want it, choose the Update Disclosure button.

If at any point you wish to exit the Disclosure Questionnaire window without saving the changes and updating the disclosure, choose the Cancel button. When you choose either the Update Disclosure or Cancel buttons, WinBench 96 automatically closes the Disclosure Questionnaire window.

Printing Disclosure information

To print Disclosure information:

1.	Select Print from the File menu in WinBench 96 main window.

2.	Select the Disclosure... option from the Print submenu.

When you print the Disclosure information, WinBench 96 prints the information currently displayed in the Disclosure window.

NOTE:	If you’re displaying results for several different types of machines, you can print disclosure information for each of them. To specify the set of comparison results for which you want to print the Disclosure, change the Description listed above the Disclosure information in the Disclosure window and then select Print from the File menu.

What the numbers mean

WinBench 96 is a subsystem-level benchmark you can use to measure the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. This section briefly explains what the results for the main tests can tell you about a PC’s performance. If you’d like more information on what can affect results and what WinBench 96 is doing when you run its tests, see the Understanding and Using WinBench( 96 Version 1.0 manual.

Remember, a PC’s configuration will affect its WinBench 96 results. Comparing results for two machines with different configurations is at best a potentially confusing experience. For more information on how to make the most accurate comparison possible, see page � PAGEREF _Ref330191491 �31�.

Bigger Marks mean better performance:  Comparing WinBench 96 results

When you first look at WinBench 96’s Chart of Results, the numbers may seem a little overwhelming. The most important thing to remember, however, is that with WinBench 96’s WinMark results, bigger numbers mean better performance.

NOTE:	“Bigger is better” doesn’t apply to all of WinBench 96 results. For example, with some video test results, lower numbers actually indicate better performance. For more information on what the video test results can tell you, see page � PAGEREF _Ref335108227 �27�.

To make it easier to understand a PC’s results, you can choose a set of results to use as a baseline system. When you select a baseline system, WinBench 96 sets that system’s results to 1 and displays all other results as a fraction of the baseline system’s results.

When you set a baseline system, the bar graph for a set of results that is faster (or better) than the baseline system’s will be more than 1, while the bar graph for a set of results that is slower (or worse) than the baseline system’s will be less than 1.

For example, say Machine A scores 335 Thousand Bytes/Second and Machine B scores 708 Thousand Bytes/Second on the Disk WinMark 96 suite. You can tell from the absolute results that the disk subsystem on Machine B is faster than the disk subsystem on Machine A.

However, if you set Machine A as the baseline system, then WinBench 96 sets that system’s results to 1 and displays Machine B’s result as a fraction of Machine A’s result—2.11. Thus, using the baseline system, you can quickly see in the Chart of Results that Machine B’s disk subsystem is a little more than twice as fast as Machine A’s.

The Graphics WinMark 96

The Graphics WinMark suite gives you an overall comparative measure of the performance of a PC’s graphics subsystem by focusing on graphics operations. It performs a mix of Graphics Device Interface (GDI) painting operations that top�selling Windows�based applications use. The tests the Graphics WinMark includes perform operations such as memory to screen BitBlts and screen to screen BitBlts and operations that draw both geometric objects (such as lines, circles, and rectangles) and text.

How we created the suite

To determine which graphics operations to include in the Graphics WinMark suite, we profiled the 13 Windows�based applications Winstone 96 uses in its overall test. The application profiles determine the distribution, frequency, and typical parameters of these operations.

To make certain our profiling was as accurate as possible, we developed a tool that records application drawing operations without interfering or modifying the original application. Using this tool, we recorded the graphics operations for each of the 13 applications.

What the suite does when you run it

The Graphics WinMark suite consists of 13 Combined GWM tests (Combined GWM1 through Combined GWM13). Each of the Combined GWM tests executes a different set of graphics tests. When you choose the Graphics WinMark suite, WinBench 96 runs each of the Combined GWM tests, beginning with Combined GWM1 and moving sequentially through the tests to Combined GWM13.

Each graphics test included in a Combined GWM test executes a series of graphics functions. What you’ll see on the PC’s screen is WinBench 96 drawing many types of shapes, pictures, and text. The Combined GWM tests use a mixture of GDI functions to make sure WinBench 96 doesn’t execute the same graphics function over and over. For example, instead of drawing a line of the same length in the same place many times, the tests draw lines of many different lengths at many different locations on the screen intermingled with other types of drawing operations.

What the results can tell you

Once the tests complete, WinBench 96 returns a single result called the Graphics WinMark 96. This result is a weighted harmonic mean of the 13 Combined GWM tests results.

The Graphics WinMark 96 result tells you the number of millions of pixels per second the PC was able to draw during the test. With this result, bigger numbers mean better performance.

You can use the Graphics WinMark 96 result to determine how to optimize the PC’s graphics subsystem to best suit your needs. For example, the Graphics WinMark can help you determine how effectively graphics accelerator cards operate in a Windows environment and process Windows GDI calls. Windows applications use GDI operations to display and draw objects on the screen.

The Graphics WinMark suite also lets you determine the relative speeds of different screen resolutions and color depths on a single display card. For example, you can run the Graphics WinMark suite multiple times on the same PC, changing the screen resolution or color depth each time, and then compare the results for the different test runs.

If you’d like more information on how WinBench 96 computes the Graphics WinMark or how we determined the weights for the tests, see the Understanding and Using WinBench( 96 Version 1.0 manual.

The Disk WinMark 96

The Disk WinMark 96 suite focuses on disk operations and provides an overall comparative measure of the performance of a PC’s disk subsystem.

How we created the suite

The Disk Mix consists of 13 different sections. Each section executes a set of disk operations corresponding to the operations performed by one of the 13 applications included in Winstone. Each of the 13 sections has two phases. In the first phase of each section, WinBench 96 creates the files and directories it needs for the test. (WinBench 96 doesn’t time this phase of the test.) In the second phase of each section, WinBench 96 times how long it takes the PC to complete the disk operations.

We gathered information on what types of disk operations Windows�based applications perform by profiling the 13 top�selling applications Winstone 96 runs during its overall test. The Disk WinMark is an almost exact playback of these disk operations.

To make certain our profiling was as accurate as possible, we developed a tool that records application I/O operations, including hard disk operations and CD-ROM operations, without interfering or modifying the original application. Using this tool, we recorded the disk operations for each of the 13 applications and then combined these into one disk mix.

What the suite does when you run it

When you run the Disk WinMark 96 suite, you actually run a single large test called the Disk Mix. The Disk Mix executes a series of disk operations similar to typical disk operations that leading applications perform. It creates and deletes files, moves data in chunks of different sizes, intersperses write and read operations, and works with multiple files at the same time. While the suite is running, WinBench 96 displays a status dialog box on the PC’s screen.

�What the results can tell you

The Disk WinMark 96 suite returns a single result called the Disk WinMark. When the suite finishes, there are 13 numbers—one for each timed section. As WinBench 96 completes each section’s timed phase, it computes the bytes per second rate for that section. The bytes per second rate is the rate at which the PC performs the disk operations in that section of the test. WinBench uses a harmonic mean, with the same weights Winstone uses for these applications, to average these 13 numbers.

The Disk WinMark 96 result tells you the number of thousands of bytes per second the PC was able to transfer during the test. With this result, bigger numbers mean better performance.

The Disk WinMark results can tell you how well the PC’s disk subsystem performs when executing these disk operations. Because the test mimics the kind of work applications do, you can use the results as a guide to the kind of throughput you can expect to see when working with the PC’s disk subsystem.

If you’d like more information on how WinBench 96 computes the Disk WinMark, see the Understanding and Using WinBench( 96 Version 1.0 manual.

The CD-ROM WinMark 96

The CD-ROM WinMark 96 suite focuses on CD-ROM operations and provides an overall comparative measure of a PC’s CD-ROM subsystem. (When you run the CD-ROM WinMark 96 suite, the CD�ROM that includes WinBench 96 must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

How we created the suite

To create the CD-ROM WinMark suite, we profiled six of today’s most popular Windows CD�ROM applications. To make certain our profiling was as accurate as possible, we developed a tool that records application I/O operations, including hard disk operations and CD-ROM operations, without interfering or modifying the original application. Using this tool, we recorded the CD-ROM operations for each of the six applications and then combined these into one CD-ROM mix.

We wanted to represent a wide variety of applications and to use some of the most popular CD-ROM applications available today. So, we began by grouping CD-ROM applications into three general categories:  Business and Productivity, Games and Entertainment, and Reference and Education. Then, based on market research, we chose two of the most popular Windows-based applications from each group.

Here is an alphabetized list of the applications we profiled:

Business and Productivity	Corel GALLERY™ 2�Quicken® for Windows CD-ROM Deluxe Edition™

Games and Entertainment	Disney’s Animated StoryBook—The Lion King�Myst™

Reference and Education	Compton’s Interactive Encyclopedia™�Microsoft® Encarta™ ’95

What the suite does when you run it

When you run the CD-ROM WinMark 96 suite, you actually run a single large test called the CD-ROM Mix. The CD-ROM Mix consists of six different sections. Each section executes a set of CD-ROM operations corresponding to the operations performed by one of the six profiled applications. While the suite is running, WinBench 96 displays a status dialog box on the PC’s screen.

What the results can tell you

The CD-ROM WinMark 96 suite returns a single result called the CD-ROM WinMark. When the suite finishes, there are six numbers—one for each section of the suite. As WinBench 96 completes each section, it computes the average transfer rate for that section. WinBench 96 then uses a weighted harmonic mean to calculate the average transfer rate for the PC’s CD�ROM subsystem in thousands of bytes per second. The weighted transfer rate gives you a number closely tied to the way popular Windows-based CD-ROM programs use the PC’s CD-ROM subsystem.

The CD-ROM WinMark 96 result tells you the number of thousands of bytes per second the PC was able to transfer during the text. With this result, bigger numbers mean better performance.

If you’d like more information on how WinBench 96 computes the CD-ROM WinMark or how we determined the weights for the tests, see the Understanding and Using WinBench( 96 Version 1.0 manual.

The processor tests:  CPUmark32 and CPUmark16

The CPUmark32 and CPUmark16 tests measure the performance of x86 processors running different workloads.

The CPUmark32 measures the processor subsystem’s speed at running 32-bit Windows applications.

The CPUmark16 measures the processor subsystem’s speed at running 16-bit Windows applications.

When you run one of these processor tests, WinBench 96 runs a large instruction mix that carefully emulates the processor activity of real-world applications. The CPUmark32 executes 32-bit operations, and the CPUmark16 executes 16�bit operations.

Both tests are useful tools for measuring how well a PC’s processor subsystem—its CPU, RAM, cache, and cache controller—will perform when running 32-bit and 16-bit Windows software. Each processor test focuses solely on a PC’s processor subsystem. They perform no I/O operations or other functions that might involve a PC’s graphics or disk subsystems.

The video tests

WinBench 96’s video tests provide a concrete measure of a PC’s ability to play full-motion video. Video playback functions stress multiple areas of the PC, including the PC’s processor and graphics subsystems, as well as the CD-ROM or disk subsystems, depending on the location of the video clips you’re playing. (The CD�ROM that includes WinBench 96 also includes WinBench 96’s video clips. When you run a video test, that CD�ROM must be in the CD-ROM drive so WinBench 96 can find the files it needs to run the test.)

How we created the video clips

WinBench 96 includes two types of video clips:  talking head and action. The WinBench 96 talking head video clip is a movie of a person talking. The WinBench 96 action video clip is a movie of a running carousel.

WinBench 96’s full-motion video tests include the talking head video clip because it is the most common video type businesses make. WinBench 96 includes the action clip to really stress the PC.

�To create WinBench 96’s video clips, we contracted with a professional studio—Videofonics of Raleigh, North Carolina. Videofonics filmed the talking head clip in their studio using a professional actor. The digitization and compression of a video clip from the original video tape can cause artifacts to appear in the video clip. To reduce this effect, a well-produced commercial clip will include a busy background. Videofonics, therefore, used a paint-spattered background for the WinBench 96 talking head video clip.

For the action footage, Videofonics rented the Pullen Park carousel, also in Raleigh. Using a three-person camera crew, lighting designer, and movie production lights, the crew filmed over three hours of footage of the carousel running. The video clips WinBench 96 includes are distilled from that footage.

Videofonics shot the original footage on BetaSP, giving the best possible source video. Then, under ZDBOp’s direction, Videofonics edited the original footage using a linear digital editing system and output the result to a D2 tape. After dubbing the D2 tape to BetaSP, we sent the footage to Ledge Multimedia of Cambridge, Massachusetts, for digitization. Ledge Multimedia digitized the edited footage using an Avid system and then converted the digitized images to uncompressed QuickTime movies. These uncompressed QuickTime movies were the source for all of the compressed clips WinBench 96 uses in its full-motion video tests.

WinBench 96 uses the most common CODECs, resolutions, and data rates for each video clip.

What a test does when you run it

For each video test, WinBench 96 plays a video clip three times. (If you’d like information on what a video clip does frame�by�frame, see page � PAGEREF AppendixBVideo �39�.) For each video clip, WinBench 96 measures the:

Number of frames dropped.

Number of audio breaks.

Percent nominal speed.

Maximum number of frames per second (fps) the PC can display. In this section of the test, WinBench 96 runs the video clip without sound as fast as it can.

CPU utilization while the video clip is running.

NOTE:	The first time you run a video test, there is a pause between the second and third sections while WinBench 96 computes the performance of the CPU for use in the CPU utilization measurement.

What the results can tell you

For each video test, WinBench 96 produces five results. In most other tests, the larger the WinBench 96 test result, the better the performance. With WinBench 96’s video tests, however, bigger numbers do not always mean better performance. The chart on the next page explains what a video test result can tell you.

�

This result:�Tells you about:�And you want to see:��Frames Dropped�The PC’s ability to keep up while playing the test’s video clip.�Lower numbers are better, because the fewer frames the PC drops during the video clip, the better the subjective quality of the picture. WinBench 96 also adds a note to the Table of Results indicating the total number of frames for the video clip.��Audio Breaks�The PC’s ability to play the video clip’s audio without gaps in the sound.�Lower numbers are better, because the fewer breaks in the audio, the better the subjective quality of the sound.��Percent Nominal Speed�The speed at which the video clip ran versus the speed at which it should have run, shown as a percentage.�The ideal percentage is 100.

•	If the percentage is greater than 100, it took the PC less time to run the video clip than the actual length of the video clip.

•	If the percentage is less than 100, it took the PC more time to run the video clip than the actual length of the video clip.

All video clips are 15 seconds long except for one long video clip, which runs 120 seconds. If you’re hearing a high number of audio breaks, then the Percent Nominal Speed will probably be less than 100 percent.��Frames/Sec�The number of frames per second the PC was able to display during the video clip when WinBench 96 plays every frame of the video clip as fast as it possibly can without sound.�Higher numbers are better, because the more frames per second the PC can display, the more time it has to do other things.��Percent Used�The percentage of the total processor time the PC spends running the video clip.�Lower numbers are better, because the less time the CPU spends running the video clip, the more time it has to do other things. To determine how much CPU time is available to other 16-bit applications for other work while WinBench 96 played the video clip, subtract the Percent Used result from 100.��End of Part 4

�Part 5: �Contacting ZDBOp

This part explains how to contact us if you have problems with WinBench 96 and tells you how to request benchmarks and manuals from ZDBOp.

Getting technical support

If you have problems with WinBench 96, you can report those problems to us using the Problem Report Form. You can find the Problem Report Form, at the back of the Understanding and Using WinBench® 96 Version 1.0 manual, and on ZD Net/CompuServe Edition in the ZD Benchmark forum (GO ZDBENCH).

To submit a problem report, you can:

Post a message about the problem on the ZD Benchmark forum on ZD Net/CompuServe Edition (GO ZDBENCH). Access to CompuServe is available for a fee.

Fax the form directly to WinBench 96 Technical Support (919-380-2879).

Mail the form to us at the following address:

	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560

	Attn.: WinBench 96 Technical Support

Requesting a benchmark

If you’d like to request copies of WinBench 96 or other Ziff-Davis benchmarks, fill out a Benchmark Request Form and then:

Fax it to our dedicated benchmark request fax number (919-380-2879).

Mail it to us at:

	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560

	Attn.:  Distribution Coordinator

End of Part 5

�Appendix A: �Basic Concepts

This section gives a brief introduction to some basic WinBench 96 concepts. For more information on WinBench 96’s design concepts and testing procedures, see the Understanding and Using WinBench( 96 Version 1.0 manual.

WinBench 96:  A brief definition

WinBench 96 is a subsystem-level benchmark that measures the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. WinBench 96’s tests perform many of the same operations applications commonly execute. For WinBench 96, we profiled the same Windows-based applications Winstone 96 uses. These applications cover top-selling Windows product areas, including database, business graphics and desktop publishing, spreadsheet, and word processing.

NOTE:	WinBench 96 doesn’t run actual applications during its tests. Instead, the tests mimic the operations leading Windows-based applications perform.

WinBench 96 returns five main results that provide an overview of a PC’s graphics, disk, processor, and CD�ROM subsystems performance—the Graphics WinMark 96, Disk WinMark 96, the CPUmark�16��� and CPUmark�32�, and the CD-ROM WinMark 96. In addition, the benchmark includes full-motion video tests to measure the PC’s video subsystem performance.

Making sure a comparison is valid

Once you’ve run WinBench 96, you’ll want to use its results to judge a PC’s performance. You should, however, remember a few very important details before you begin making any comparisons:

1.	IMPORTANT!  You can’t meaningfully compare the most current release’s results with results from previous versions of WinBench. Each new version of WinBench includes substantial changes, and those changes affect results. So, you should always compare results from the same version of WinBench.

2.	If you have time, read through the section “� REF _Ref324845428 \* MERGEFORMAT �What the numbers mean�” beginning on page � PAGEREF _Ref324845428 �22�. That section explains the units for each of WinBench 96’s main tests and whether bigger or smaller numbers indicate better performance.

3.	If you’re trying to determine which of two PCs outperforms the other, keep in mind that a PC’s hardware and software setup affects its performance. To find out about a PC’s system information at the time you ran WinBench 96, you can view its Disclosure information (for more details, see page � PAGEREF _Ref335115556 �21�).

End of Appendix A

�Appendix B: �The Custom Configuration File

You can use WinBench 96’s configuration check to compare the test PC’s setup and configuration to pre�defined settings in a custom configuration file.

This appendix explains how to create a custom configuration file, how WinBench 96 uses a custom configuration file, and summarizes the command set you can use to build the file. Following the list of available commands, you'll find examples you can modify for a custom file.

Creating a custom configuration file

WinBench 96 includes a prototype configuration file, SAMPLE.CFG, in the \ZDBENCH\WB96 directory on the CD�ROM.

To create a custom configuration file:

1.	Copy the SAMPLE.CFG file to another file name, such as CUSTOM.CFG.

2.	Edit the new file so it contains the configuration information you want WinBench 96 to check. (The section “� REF _Ref336140506 \* MERGEFORMAT �Functions�” beginning on page � PAGEREF _Ref336140508 �35� provides details on the list of available commands. For a few examples to use as guidelines when you edit the file, see page � PAGEREF _Ref334427900 �37�.)

Once you’ve edited and saved the custom file, you’ll need to load the file during the WinBench 96 session for WinBench 96 to use it during its configuration check (see page � PAGEREF _Ref327694797 �10� for more information).

How WinBench 96 uses a custom file

After you load a custom file, WinBench 96 compares the test PC’s system configuration with the settings in the custom file before each test run.

To increase the speed of execution, WinBench 96 parses the custom configuration file entirely within memory. Thus, a custom configuration file must be less than 64KB in size.

WinBench 96 executes the custom configuration file one line at a time. The file contains five elements:  Comments, Entry = lines, [section] lines, Functions, and Expressions.

The remainder of this appendix describes each of these elements.

Comments

Comments in a custom configuration file explain what each command in the file does. You enter comments in the file using two adjacent slashes (//) at the beginning of the line. The comment can start anywhere on a line and extends until the next new line. WinBench 96 treats double slashes enclosed within quotation marks (“ ”) as part of a literal string and not a comment.

Comments are for your use only; WinBench 96 ignores all text within a comment.

entry = lines

WinBench 96 uses entry = lines to retrieve information from the test PC’s environment variables, the benchmark’s disclosure fields, or the PC’s .INI files. You can specify where the entry = line looks for information by using the #focus( ) function described on page � PAGEREF _Ref336242591 �35�.

All entry = lines have the following general syntax:

entry = [FormatString,] VariableList

Where:

entry is the name of the environment variable, disclosure field, or .INI file entry whose value you want to retrieve. WinBench 96 scans the value of entry as a series of input fields.

FormatString defines a format specifier (similar to the C sscanf( ) function).

The FormatString option recognizes three format specifiers:  %d, %f, and %s. With these three format specifiers the parser can format integers (from -2,147,483,684 to 2,147,483,687), floating point numbers (from 1.7 x 10-308 to 1.7 x 10308), and strings.

You don’t have to specify a FormatString option. If the FormatString is missing, WinBench 96 stores the contents of entry in the one variable you specify. This is useful for reading entire strings, rather than formatting them one token at a time.

VariableList defines where you want WinBench 96 to store the formatted input.

The VariableList option can contain up to 32 variables, separated by commas. Variable names must be unique within the first 31 characters and must follow C rules for naming variables.

Variables are only valid until the next entry = line. The VariableList for each entry = line replaces the VariableList from the previous entry = line.

[section] lines

A [section] line specifies the section WinBench 96 uses when retrieving entries from an .INI file. You can use [section] lines only if the current focus is an .INI file; otherwise, WinBench 96 will issue an error message because it cannot find the .INI file. You can set the focus using the #focus( ) function (see page � PAGEREF _Ref336242622 �35�).

Functions

The following sections discuss the functions you can use to build a custom configuration file.

#if(expression)

You can use the #if(expression) function to check if certain conditions exist on the test PC. You can use the following BOOL operators in the #if function:

&&	numbers only�||	numbers only�==	numbers and strings�!=	numbers and strings�in	strings only�<	numbers and strings�<=	numbers and strings�>	numbers and strings�>=	numbers and strings

For information on variables you can use in the (expression) see the section “� REF _Ref336143498 \* MERGEFORMAT �Expressions�” on page � PAGEREF _Ref336143498 �36�.

#else

The #else function tells the benchmark what to do if the #if function is not true. The #else function is optional.

#endif

The #endif function marks the end of the #if function.

#focus(FOCUS)

The #focus(FOCUS) function sets the system location where the benchmark retrieves configuration information.

Valid values for FOCUS are:

Disclosure	benchmark disclosure fields�Environment	environment variables�inifile	.INI file name

#text(FormatString[,VariableList])

The #text(FormatString[,VariableList]) function overrides the default text for the previous entry = line. WinBench 96 displays this text in the top portion of the Configuration Information window. The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#note(FormatString[,VariableList])

The #note(FormatString[,VariableList]) function links a note to the previous entry = line. WinBench 96 displays this note in the Note section of the Configuration Information window when the tester selects the corresponding text message in top portion of that window.

The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#notify(void)

The #notify(void) function notifies the benchmark of a conflict. When the benchmark receives a #notify function, it displays either a default text message or text specified in the #text function in the Configuration Information window. If the tester supplies a note, the benchmark displays this note in the Note text box.

Expressions

The general syntax for an expression is:

A operator B

A and B can be any of the following:

A variable name.

A string or numeric constant.

One of the following pre-defined constants:

TRUE	1�FALSE	0�WIN16	TRUE if OS is 16-bit Windows.�WFWG	TRUE if OS is Windows for Workgroups.�WIN95	TRUE if OS is Windows 95.�WINNT	TRUE if OS is Windows NT.�DISKSPACE	Amount of free space on the working drive.�FREEMEM	Amount of free memory.�SYSTEMRAM	Amount of processor RAM.

Another expression.

The operator can be any one of the following:

<	less than�<=	less than or equal to�>	greater than�>=	greater than or equal to�==	equal to�!=	not equal to�&&	logical AND�||	logical OR�in	tests if A is a substring of B

Examples

This section provides examples you can build upon for a custom configuration file (see the SAMPLE.CFG file in the \ZDBENCH\WB96 directory).

Checking DOS environment variables

If you want WinBench 96’s system to check to verify DOS environment variables before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the DOS environment variables.�#focus(Environment)�// Read the "TEMP" variable as a string and store the value�// in ENVVAR.�TEMP = envvar�// If ENVVAR is empty, set NOTE and call NOTIFY to update �// the Configuration Information Window.�#if (envvar != "")�#else�	#note(“You need to set the TEMP environment variable in the AUTOEXEC.BAT file. For example, ‘TEMP=C:\DOS’.”�	#notify()�#endif

Checking entries in WIN.INI

If you want WinBench 96’s system to check to verify entries in the PC’s WIN.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the WIN.INI file.�#focus("win.ini")�// Set the topic to the [windows] section of the WIN.INI file.�[windows]�// Read the "run" entry in the [windows] section as a �// string and store the value in RUNVAR.�run = runvar�// If RUNVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (runvar != "")�	#note ("The 'run =' line in the WIN.INI file should be empty.")�	#notify()�#endif�// Read the "load" entry in the [windows] section as a �// string and store the value in LOADVAR.�load = loadvar�// If LOADVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (loadvar != "")�	#note ("The 'load =' line in the WIN.INI file should be empty.")�	#notify()�#endif

Checking entries in SYSTEM.INI

If you want WinBench 96’s system to check to verify entries in the PC’s SYSTEM.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the SYSTEM.INI file.�#focus("system.ini")�// Set the topic to the [boot] section of the SYSTEM.INI �// file.�[boot]�// Read the "shell" entry in the [boot] section as a string �//and store the value in SHELLVAR.�shell = "%s", shellvar�// If SHELLVAR is not equal to "PROGMAN.EXE", set NOTE and �// call NOTIFY.�#if (shellvar != "progman.exe")�	#note("We've only tested WinBench 96 on systems running Windows PROGMAN.EXE as the shell program.")�	#notify()�#endif

End of Appendix B

�Appendix C: �The Video Clips

This appendix briefly explains what you should see at certain frame numbers during each type of video test. This appendix includes this level of detail because when you first run a WinBench 96 video test, it may be difficult to distinguish between actual display problems and the editing of the video. (For information on how to run a video test, see page � PAGEREF _Ref330197959 �13�.)

This appendix also provides a chart that maps each video test name to the .AVI video clip file that test runs and a chart that lists the attributes for each .AVI video clip file.

Frame by frame—What you’ll see in the video clips

WinBench 96 includes two types of video clips:  talking head and action. The WinBench 96 talking head video clip is a movie of a person talking. The WinBench 96 action video clip is a movie of a running carousel.

Talking head video clips

Each talking head video clip is 15 seconds long and shows a person reciting the following lines:

What you are watching is a WinBench test of your PC’s ability to play full-motion video. You should look for three things:  The motion should appear smooth, the sound should not have any unexpected breaks, and the audio should be synchronized with the video.

Action video clips

Each action video clip is 15 seconds long except for one long video clip that lasts 120 seconds. The action video clips show different scenes of a moving carousel and include background music. The following tables list the different scenes in the action video clips.

NOTE:	The numbers listed in these tables identify the frame number per second using the following format:  <minutes>:<seconds>:<frame number>. Frame numbers run from 0-29, or 30 frames per second. (30 fps is the industry-standard frames per second rate.) For example, the number 14:29 indicates the 29th (last) frame at the 14-second mark of the video clip, and the number 01:10:05 indicates the 5th frame at the 1 minute and 10-second mark of the video clip.

�Table 1:  15-second video clips

In these frame numbers:�You’ll see:��00:00—04:29�The carousel accelerating.��05:00�A cut to a different scene.��05:00—9:29�The carousel running at full speed. Two carousel rabbits cross the frame.��10:00�A cut to a different scene.��10:00—14:29�The carousel slowing down.��Table 2:  120-second video clip

In these frame numbers:�You’ll see:��00:00:00—00:04:29�The carousel accelerating.��00:05:00—00:06:11�Screen splits to reveal shot of carousel horse’s head.��00:06:12—00:07:14�Still shot of the carousel horse’s head.��00:07:15—00:08:22�Hole opens in center to reveal the running carousel.��00:08:23—00:12:13�Carousel runs.��00:12:14—00:13:28�8-sectioned wipe to a carousel horse’s head.��00:13:29—00:14:29�Still shot of the carousel horse’s head.��00:15:00—00:16:14�Clock-sweep wipe to reveal the running carousel.��00:16:15—00:19:29�Carousel runs.��00:20:00—00:21:13�Jagged-edge wipe from upper-left corner to reveal carousel horse’s head.��00:21:14—00:22:14�Still shot of the carousel horse’s head.��00:22:15—00:22:22�Fade to the running carousel.��00:22:23—00:25:00�Carousel horse passes through the frame.��00:25:01—00:25:09�Fade to a brown carousel horse.��00:25:10—00:29:02�Carousel horse passes through the frame.��00:29:03—00:29:10�Fade to carousel rabbits.��00:29:11—00:34:13�Carousel rabbits pass through the frame.��00:34:14—00:34:21�Fade to a carousel horse.��00:34:22—00:36:14�Carousel horse passes through the frame.��00:36:15—00:36:24�Flash to a carousel tiger’s head.��00:36:25—00:38:21�Still shot of the carousel tiger’s head.��00:38:22—00:40:04�Psychedelic wipe to the running carousel.��00:40:05—00:46:07�Carousel runs.��00:46:08—00:46:29�Circular wipe from upper-right and lower-left corners to reveal carousel horse’s head.��00:47:00—00:47:20�Still shot of carousel horse’s head.��00:47:21—00:48:12�Jagged-burst wipe from center to reveal carousel horse’s head bobbing up and down.��00:48:13—00:54:08�The carousel horse’s head bobs up and down.��00:54:09—00:54:16�Fade to a carousel bird’s head.��00:54:17—01:01:02�The carousel bird’s head bobs up and down.��01:01:03—01:01:11�Fade to two carousel horse’s heads.��01:01:12—01:03:04�The carousel horses’ heads bob up and down.��01:03:04—01:03:12�Fade to a carousel cat with a fish in its mouth.��01:03:13—01:06:02�The carousel cat’s head bobs up and down.��01:06:03—01:06:10�Fade to two carousel horses.��01:06:11—01:09:10�The carousel horses’ heads bob up and down.��01:09:11—01:10:04�Heart-shaped wipe from center to reveal a carousel giraffe’s head.��Table 2:  120-second video clip (continued)

In these frame numbers:�You’ll see:��01:10:05—01:11:15�Still shot of a carousel giraffe’s head.��01:11:16—01:12:08�Page-turn wipe to the carousel running as seen from the inside of the carousel.��01:12:09—01:21:09�Carousel runs.��01:21:10—01:21:28�Building-block wipe from left side to carousel horse’s head.��01:21:29—01:22:29�Still shot of carousel horse’s head.��01:23:00—01:23:22�Rectangular wipe from upper-left to the running carousel.��01:23:23—01:29:12�Carousel runs.��01:29:13—01:30:09�Jagged, multisection wipe reveal carousel bird’s head.��01:30:10—01:32:07�Still shot of carousel bird’s head.��01:32:08—01:33:05�Carousel bird’s head shrinks and flips into center to reveal the running carousel.��01:33:06—01:43:20�Carousel runs.��01:43:21—01:44:13�Wavy, rotating wipe from center to the carousel slowing down.��01:44:14—01:59:29�Carousel slows almost to a stop.��Mapping the video test names to the video clip file names

The following chart lists the .AVI video clip file name WinBench 96 runs for each video test.

Test name:�Video clip file name:��Video/Action(Long), Indeo, 320x240, 30fps, 300KB/S�INAC3L3L.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�CPAC3S3S.AVI��Video/Action, Cinepak, 160x120, 30fps, 300KB/S, Full�CPAC3S3S.AVI��Video/Action, Cinepak, 320x240, 15fps, 300KB/S�CPAC1L3S.AVI��Video/Action, Cinepak, 320x240, 25fps, 300KB/S�CPAC2L3S.AVI��Video/Action, Cinepak, 320x240, 30fps, 300KB/S�CPAC3L3S.AVI��Video/Action, Cinepak, 640x480, 15fps, 900KB/S�CPAC1H9S.AVI��Video/Action, Cinepak, 640x480, 30fps, 900KB/S�CPAC3H9S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 1.7x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 2.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, 4.0x�INAC3S3S.AVI��Video/Action, Indeo, 160x120, 30fps, 300KB/S, Full�INAC3S3S.AVI��Video/Action, Indeo, 320x240, 15fps, 250KB/S�INAC1L2S.AVI��Video/Action, Indeo, 320x240, 15fps, 300KB/S�INAC1L3S.AVI��Video/Action, Indeo, 320x240, 15fps, 450KB/S�INAC1L4S.AVI��Video/Action, Indeo, 320x240, 15fps, 600KB/S�INAC1L6S.AVI��Video/Action, Indeo, 320x240, 25fps, 250KB/S�INAC2L2S.AVI��Video/Action, Indeo, 320x240, 25fps, 300KB/S�INAC2L3S.AVI���

Test name:�Video clip file name:��Video/Action, Indeo, 320x240, 25fps, 450KB/S�INAC2L4S.AVI��Video/Action, Indeo, 320x240, 25fps, 600KB/S�INAC2L6S.AVI��Video/Action, Indeo, 320x240, 25fps, 750KB/S�INAC2L7S.AVI��Video/Action, Indeo, 320x240, 30fps, 250KB/S�INAC3L2S.AVI��Video/Action, Indeo, 320x240, 30fps, 300KB/S�INAC3L3S.AVI��Video/Action, Indeo, 320x240, 30fps, 450KB/S�INAC3L4S.AVI��Video/Action, Indeo, 320x240, 30fps, 600KB/S�INAC3L6S.AVI��Video/Action, Indeo, 320x240, 30fps, 750KB/S�INAC3L7S.AVI��Video/Action, Indeo, 640x480, 15fps, 900KB/S�INAC1H9S.AVI��Video/Action, Indeo, 640x480, 30fps, 900KB/S�INAC3H9S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 1.7x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 2.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, 4.0x�CPTK3S3S.AVI��Video/Head, Cinepak, 160x120, 30fps, 300KB/S, Full�CPTK3S3S.AVI��Video/Head, Cinepak, 320x240, 15fps, 300KB/S�CPTK1L3S.AVI��Video/Head, Cinepak, 320x240, 25fps, 300KB/S�CPTK2L3S.AVI��Video/Head, Cinepak, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI��Video/Head, Cinepak, Clipped, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI��Video/Head, Cinepak, Unaligned, 320x240, 30fps, 300KB/S�CPTK3L3S.AVI��Video/Head, Indeo, 160x120, 30fps, 150KB/S�INTK3S1S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 1.7x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 2.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, 4.0x�INTK3S3S.AVI��Video/Head, Indeo, 160x120, 30fps, 300KB/S, Full�INTK3S3S.AVI��Video/Head, Indeo, 320x240, 15fps, 150KB/S�INTK1L1S.AVI��Video/Head, Indeo, 320x240, 15fps, 300KB/S�INTK1L3S.AVI��Video/Head, Indeo, 320x240, 25fps, 150KB/S�INTK2L1S.AVI��Video/Head, Indeo, 320x240, 25fps, 300KB/S�INTK2L3S.AVI��Video/Head, Indeo, 320x240, 30fps, 150KB/S�INTK3L1S.AVI��Video/Head, Indeo, 320x240, 30fps, 300KB/S�INTK3L3S.AVI���Video clip attributes

The following chart list the video attributes for each .AVI video clip file.

File name�Type�Secs*�Compression�Resolution�FPS† �KB/S‡�Audio Format��CPAC1H9S.AVI�Action�15�Cinepak�640x480�15�901�16bit 22KHz S��CPAC1L3S.AVI�Action�15�Cinepak�320x240�15�261�8bit 22KHz S��CPAC2L3S.AVI�Action�15�Cinepak�320x240�25�257�8bit 22KHz S��CPAC3H9S.AVI�Action�15�Cinepak�640x480�30�911�16bit 22KHz S��CPAC3L3S.AVI�Action�15�Cinepak�320x240�30�263�8bit 22KHz S��CPAC3S3S.AVI�Action�15�Cinepak�160x120�30�253�8bit 22KHz S��CPTK1L3S.AVI�Talking Head�15�Cinepak�320x240�15�265�8bit 22KHz M��CPTK2L3S.AVI�Talking Head�15�Cinepak�320x240�25�258�8bit 22KHz M��CPTK3L3S.AVI�Talking Head�15�Cinepak�320x240�30�262�8bit 22KHz M��CPTK3S3S.AVI�Talking Head�15�Cinepak�160x120�30�247�8bit 22KHz M��INAC1H9S.AVI�Action�15�Indeo�640x480�15�917�16bit 22KHz S��INAC1L2S.AVI�Action�15�Indeo�320x240�15�216�8bit 22KHz S��INAC1L3S.AVI�Action�15�Indeo�320x240�15�256�8bit 22KHz S��INAC1L4S.AVI�Action�15�Indeo�320x240�15�389�16bit 22KHz S��INAC1L6S.AVI�Action�15�Indeo�320x240�15�515�16bit 22KHz S��INAC1L7S.AVI�Action�15�Indeo�320x240�15�525�16bit 22KHz S��INAC2L2S.AVI�Action�15�Indeo�320x240�25�225�8bit 22KHz S��INAC2L3S.AVI�Action�15�Indeo�320x240�25�256�8bit 22KHz S��INAC2L4S.AVI�Action�15�Indeo�320x240�25�384�16bit 22KHz S��INAC2L6S.AVI�Action�15�Indeo�320x240�25�524�16bit 22KHz S��INAC2L7S.AVI�Action�15�Indeo�320x240�25�782�16bit 22KHz S��INAC3H9S.AVI�Action�15�Indeo�640x480�30�914�16bit 22KHz S��INAC3L2S.AVI�Action�15�Indeo�320x240�30�219�8bit 22KHz S��INAC3L3L.AVI�Action�120�Indeo�320x240�30�257�8bit 22KHz S��INAC3L3S.AVI�Action�15�Indeo�320x240�30�260�8bit 22KHz S��INAC3L4S.AVI�Action�15�Indeo�320x240�30�389�16bit 22KHz S��INAC3L6S.AVI�Action�15�Indeo�320x240�30�529�16bit 22KHz S��INAC3L7S.AVI�Action�15�Indeo�320x240�30�790�16bit 22KHz S��INAC3S3S.AVI�Action�15�Indeo�160x120�30�258�8bit 22KHz S��INTK1L1S.AVI�Talking Head�15�Indeo�320x240�15�130�8bit 22KHz M���

File name�Type�Secs*�Compression�Resolution�FPS† �KB/S‡�Audio Format��INTK1L3S.AVI�Talking Head�15�Indeo�320x240�15�162�8bit 22KHz M��INTK2L1S.AVI�Talking Head�15�Indeo�320x240�25�132�8bit 22KHz M��INTK2L3S.AVI�Talking Head�15�Indeo�320x240�25�260�8bit 22KHz M��INTK3L1S.AVI�Talking Head�15�Indeo�320x240�30�145�8bit 22KHz M��INTK3L3S.AVI�Talking Head�15�Indeo�320x240�30�259�8bit 22KHz M��INTK3S1S.AVI�Talking Head�15�Indeo�160x120�30�129�8bit 22KHz M��INTK3S3S.AVI�Talking Head�15�Indeo�160x120�30�145�8bit 22KHz M��End of Appendix C

�BENCHMARK REQUEST FORM

Please check the boxes of the products you want:

___	PC Benchmarks CD-ROM containing Winstone® and WinBench® for desktop PCs running Windows®.

___	Server Benchmarks CD-ROM containing NetBench® for file servers and ServerBench® for client/servers (for x86-compatible processors).

___	Macintosh Benchmark CD-ROM containing MacBench® for Mac™ OS Systems.

Please send these products to:

Name: ______________________________________________________________________________

Company: ___________________________________________________________________________

Address: ____________________________________________________________________________

City: _____________________________________ State: ______________________ Zip: ___________

Country: ____________________________________________________________________________

Telephone: __________________________________ FAX: ___________________________________

We answer requests in the order we receive them. We ship all benchmarks via 3rd�class U.S. Please allow 4-6 weeks for delivery. For faster shipment, provide your Federal Express account information below:

Your Federal Express account number: ____________________________________________________

Check one:	___ priority overnight 	___ standard overnight

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560

�Problem Report Form

Information about you:

Name: ______________________________________________________________________________

Address: ____________________________________________________________________________

Company: ___________________________________________________________________________

E-mail address: ______________________________________________________________________

Phone: _____________________________________________________________________________

Fax: _______________________________________________________________________________

Benchmark you’re using: _______________________________________________________________

A description of the PC:

Example:	WXY Corp. Model 486DX-66 with 8MB of RAM, 64 KB RAM cache, 200MB hard disk, IDE controller, no hardware disk cache, running Windows 3.1 and DOS 6.0

____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

Details of the problem:

What is the problem, and what did the benchmark do just before the problem occurred? _____________�_________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

What message was in the status bar at the bottom of the benchmark’s main window ________________�___________________________________________________________________________________

Can you reproduce the problem? ______

Could you please attach the contents of the benchmark’s Disclosure and the ERRORS.TXT file? (You can find the ERRORS.TXT file in the benchmark’s main directory.)

Other comments: _____________________________________________________________________�____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560

*	We didn’t test WinBench 96 on earlier versions of these operating systems. So, we can’t guarantee it will run on them, or, if it does, that the results will be valid.

†	The CD-ROM that includes WinBench 96 also includes the versions of Video for Windows and Win32s needed to run the benchmark’s tests.

‡	The test PC must have a sound card if you plan to run WinBench 96’s full-motion video tests.

*	The length of the video clip in seconds.

†	The number of frames per seconds for the video clip.

‡	The data rate of the video clip in kilobytes per second.

*	The length of the video clip in seconds.

†	The number of frames per seconds for the video clip.

‡	The data rate of the video clip in kilobytes per second.
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